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Basic Navigation 
 

Launching a Web Browser 

Students will be asked to locate the Internet Explorer icon on their desktops and open the 
program by left clicking on the icon with the mouse twice. 

 

This will bring up the Mpilonhle Moodle Website in Internet Explorer (this site will be set as the 
default homepage for all computers) which will be the starting point for all assignments.  
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Logging into the Mpilonhle Moodle Site 

 

Students will be asked to enter their Username and Password into the text boxes on the main 
page of the Mpilonhle Moodle site.   

(The Username and Password for students will be provided in advance). 

 

 

OR 

Ask students to click onto the Mpilonhle Computer Curriculum button on the Mpilonhle main 
page.  
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This will bring students to the Login Page of the Mpilonhle site. 

 

Students will be asked to enter their Username and Password into the text boxes.  (The Username 
and Password for students will be provided in advance). 

 

Once students have logged in, they will be brought to the Mpilonhle Computer Curriculum 
assignments page. 

At this point, students will be asked to minimize their web browser programs and open Microsoft 
Word. 
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Minimizing a screen 

In the top right corner of the screen, students will see three buttons: 

Close  

 
 
   Restore Down 

 
 
      Minimize  

 
 

Explain that the Close Button will end the selected program. 

Demonstrate the Restore Down and Minimize buttons to show students that these are ways to 
diminish or hide a program and reveal the desktop and other programs. 

Ask students to minimize their internet browser windows and open up Microsoft Word. 
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Running Microsoft Word 

 

Similar to launching Internet Explorer ask students to run Microsoft Word by left clicking twice 
with the mouse on the Word icon. 

 

 

Ask students to use the Restore Down or Minimize button to reduce or hide the Microsoft Word 
program. Restoring down or minimizing is useful when switching between programs such as 
going back and forth between Microsoft Word and a Web Browser.  For more information about 
these functions see the next task. 
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Switching between Microsoft Word and Web Browser 

 

Being able to switch between a Microsoft application and Internet Explorer will be an important 
skill for students to learn to be able to complete assignments.  Many assignments will ask 
students to work with a programs including Microsoft Word and Excel and  to save and upload 
documents to the Mpilonhle site. 

Switching back and forth between programs will allow students to work on assignments and 
refer back to the Mpilonhle site for instructions.  

Exercising skills gained using the Restore Down and Minimize buttons, students can switch 
between programs by: 

1. Restoring down the Microsoft Word program and the Internet Explorer program so that 
both screens can be seen on the desktop at once (as shown below). 

Students will be able to click on either screen to work with that program. Students can 
also switch to the other program at any time by clicking on the other screen. Users can 
switch back and forth as many times as desired. 
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OR, students can switch to another program by: 

2. Using the Minimize button, students can reduce their program to the task bar (shown 
below).  Once a program is minimized simply click on the program icon on the task bar 
to restore the program screen to full size. 

By minimizing one program, students will be able to view the screen for the other 
program and can return to the original program by restoring it from the task bar (by 
clicking on the icon). 
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Submit Lesson Assignments  

 

When a student has finished an assignment, whether using Microsoft Word, Excel or 
PowerPoint, they will need to submit it to the Mpilonhle site.  The process to submit a finished 
document is the same for all three programs. 

1. Saving to the Desktop - When they have finished an assignment, a student will first save 
the document they are working to the desktop. To do this students will: 

a) Click on the Office button on the top right of the screen.  

b) On the drop down box that appears, select the Save As button 
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c) A new popup box will appear.  Select the desktop location for the file to be saved 
and type a name for the document (try to come up with a name that will be easily 
remembered).   Once the desktop has been selected and a name given to the 
document, click on the save button. 

 

d) Once saved, an icon of the saved document will appear on the desktop (see 
below).  To continue working on the document, left click twice on the icon.  
Students must remember to save any more changes to the document before 
closing the document to prevent their work from being lost. 
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2. Uploading a document to the Mpilonhle site – Once a student has finished working on 
an assignment and saved their progress to the desktop, they are ready to upload the 
document.  To do this students will: 

a) Go to the bottom of the Mpilonhle assignment page where they can upload saved 
files (see next page).  To select the saved word document click on the Browse 
button.  
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b) A popup box will appear where students will select the Desktop location and then 
select the file name they saved.  Once the file name is selected, the student will 
click the Open button.  

 

 

c) Once the student clicks the Open button, the file path will appear in the box at the 
bottom of the Mpilonhle page (see below).  The student will then select the 
Upload this file button to finish submitting. 
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Copying and pasting text and images 

 

Copying and pasting text and images is a useful way to transfer data from one source to another.  
You may want to include outside text or images in a Word document you create, or add numbers 
and other information to documents such as an Excel file. 

There are a couple of options for copying text or an image: 

1. Highlight the text or image. 

2. Right click on the text or image and select Copy. 

 

 

3. In the new document where you want 
the text or image pasted, right click and 
select Paste.  The text or image will now 
appear in the new document. 
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OR 

Instead of right clicking and selecting Copy on highlighted text and images, you can use quick 
keys to copy.   

1. Highlight the text or image. 

2. Press the Ctrl and C keys on your keyboard at the same time. 

3. The highlighted text or image will now be copied. 

4. In the new document where you want the text or image pasted, press the Ctrl and V 
keys to paste the copied text or image. 

 

OR 

You can use the copy and paste functions on the Home toolbar  

 

1. Highlight the text or image. 
2. Select the Copy button in the top left corner of the Home toolbar. 

 

 
 

3. In the new document where you want the text or image pasted, select the Paste button 
in the top left corner of the Home toolbar. 

 



16 

 

Basic Navigation Additional Material 

 

Intermediate Lesson: Creating a folder 

 

In order to organize files and easily recover saved documents, folders are created.  To create a 
folder, students can go through the following steps: 

1. Right click on the desktop or within an existing folder to bring up a menu of options.  
Select New on the drop down menu options and click on the Folder button from the drop 
down menu that appears. 
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2. A folder icon will appear and a field will be highlighted to provide a name for the folder.  
Create a name for the new folder. Students should remember to use a name that 
represents the files that will be saved within. 

  a) New folder & highlighted name field 

 

 b) New folder with name added 

 

3. Documents can be dragged and dropped into a folder by left clicking on a file and 
dragging it over the folder icon. Let go of the left mouse button to place the file into the 
folder. 
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Lesson 1: Beginner 
 

Lesson 1: Beginner will provide students with basic computer skills including how to: launch a 
program, login to a website, minimize windows, switch between programs, and save and upload 
documents. 

This lesson will also provide preliminary instruction for commonly used computer programs: 
word processors, spreadsheets, and electronic encyclopaedias. 

The lesson is broken into five 30 minute sessions on the following topics: 

 Basic Navigation 

 Microsoft Word 

 Microsoft Excel 

 Encarta  

 TypingMaster 

 

Basic Navigation (Beginner) 

Goal: To teach fundamental computer skills that will allow students to proceed through 
assignments and navigate the Mpilonhle Moodle site. 

Time:  30 minutes 

Objectives:  At the end of the Basic Navigation section, students will be able to: 

 Launch a web browser 
 Login to the Mpilonhle site 
 Open Microsoft Word  
 Switch between Microsoft Word and a web browser 
 Submit lesson assignments  

 
Material to present Basic Navigation can be found at the beginning of the Teacher’s manual.  
Additional skills for Intermediate, Advanced I and Advanced II lessons are included. 
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Microsoft Word (Beginner) 

Goal:  To teach students how to format text and paragraphs, including making changes to font, 
alignment and spacing.  These skills are useful when composing longer documents and are a 
good early exposure to the features of a word processing program. 

Time:  30 minutes 

Objectives:  At the end of the Microsoft Word section, students will be able to: 

 Format text 
 Change text font 
 Change line spacing 
 Align text 

 
 
 

What is a word processor? 

 

A word processor, like Microsoft Word, is a computer application which allows the user to 
create, edit and save documents.  Word processors are useful tools to help write papers and 
reports.  Users can write and modify text, format the page to change the appearance of the 
document and add features like images. 

A toolbar at the top of the program provides an array of features that allows users to modify the 
look and content of the spreadsheet. 

 

 

By clicking on different tabs on the toolbar new options will appear. 
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Assignment 

 
Teachers will walk students through the assignment steps and present directions for how to 
complete tasks to the class.  Instructions for how to complete each task within an assignment are 
presented along with visual aids below. 
 
Students will be asked to review the Community Word Processing assignments on the Mpilonhle 
site. 
 
Assignment 1 
 
This assignment will ask students to go through the following steps: 
 

1. Open Microsoft Word 
 

2. Type two lines of text: 
a) On the first line type their town name 
b) On the second line type their name and age 

 

3. Change the font: 
a) Change the font style for both lines to Arial  
b) Change the font size for both lines to 12pt  
c) Bold the font for the first line of text which has the town name  

 
Step 3 can be done by: 

a) Highlighting the selected text 
b) Modifying the selected text by using options on the top Home toolbar menu    

(see below): 
 
 

 
 
 
 

Note: Instead of using the Bold button on the toolbar hold the Ctrl + B on the keyboard to bold 
the highlighted text. 
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Assignment 2: Centre text 
 
This assignment will build off of the previous exercise and ask students to go through the 
following steps: 
 

1. Open Microsoft Word 
 

2. Type two lines of text: 
a) On the first line type their town name 
b) On the second line type their name and age 

 

3. Change the font: 
a) Change the font style for both lines to Arial  
b) Change the font size for both lines to 12pt  
c) Bold the font for the first line of text which has the town name  

 
4. Change the text alignment and line spacing: 

a) Align the text to centre justified  
b) Change the line spacing to double spaced  

 

Both steps 3 and 4 can be done by: 
a) Highlighting all of the text 
b) Modifying the selected text by using options on the top Home toolbar menu    

(see below): 
 
 

 

 
Note: Instead of using the Bold button on the toolbar hold the Ctrl + B on the keyboard to bold 
the highlighted text. 
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Assignment 3: Italicize text 
 
This assignment will build off of the previous exercise and ask students to go through the 
following steps: 
 

1. Open Microsoft Word 
 

2. Type two lines of text: 
a) On the first line type their town name 
b) On the second line type their name and age 

 

3. Change the font: 
a) Change the font style for both lines to Arial  
b) Change the font size for both lines to 12pt  
c) Bold the font for the first line of text which has the town name  

 
4. Change the text alignment and line spacing: 

a) Align the text to centre justified  
b) Change the line spacing to double spaced  

 
 

5. Change the font: 
a) Italicize the font for the second line of text which has your age 

 
Steps 3, 4, and 5 can be done by: 

a) Highlighting the selected text 
b) Modifying the selected text by using options on the top Home toolbar menu    

(see below): 
 

 
 

Note: Instead of using the Bold button on the toolbar hold the Ctrl + B on the keyboard to bold 
the highlighted text. 
 
Instead of using the Italicize button on the toolbar hold the Ctrl + I on the keyboard to italicize 
the highlighted text. 
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Assignment 4: Underline text 
 
This assignment will build off of the previous exercise and ask students to go through the 
following steps: 
 

1. Open Microsoft Word 
 

2. Type two lines of text: 
a) On the first line type their town name 
b) On the second line type their name and age 

 

3. Change the font: 
a) Change the font style for both lines to Arial  
b) Change the font size for both lines to 12pt  
c) Bold the font for the first line of text which has the town name  

 
4. Change the text alignment and line spacing: 

a) Align the text to centre justified  
b) Change the line spacing to double spaced  
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5. Change the text: 
a) Italicize the text for the second line of text which has your age 
b) Underline the text for the first line Town Name 

 
Steps 3, 4, and 5 can be done by: 

a) Highlighting the selected text 
b) Modifying the selected text by using options on the top Home toolbar menu    

(see below): 
 

 
 

 
6. Change the text colour by: 

a) Highlighting the selected text 
b) Modifying the selected text by using options on the top Home toolbar menu     
c) Select Font Colour button 
d) Select colour choice 

 
 
When finished, the submitted text should look like this: 
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Microsoft Excel (Beginner) 

Goal:  To teach students with basic information of how to use a spreadsheet program and present 
some of the number manipulation functions. 

Time:  30 minutes 

Objectives:  At the end of the Microsoft section, students will be able to: 

 Understand what a spreadsheet is 
 Add, subtract, divide and multiply in Excel 
 Determine totals 
 Count items 

 
 

What is a spreadsheet? 

 

A spreadsheet program allows users to manipulate numbers easily.  You can use it for 
calculations, to sort data or create graphs.  A spread sheet is like an electronic version of a paper 
worksheet.   

The spreadsheet consists of columns and rows made up of individual cells.  Numbers, letters and 
formulas can be put into these cells.  Formulas are added to cells to define how to calculate the 
information in the cells.  Examples of this will be shown in the Excel assignment. 

A toolbar at the top of the program provides an array of features that allows users to modify the 
look and content of the spreadsheet. 
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Assignment 

 
Teachers will walk students through the assignment steps and present directions for how to 
complete tasks to the class.  Instructions for how to complete each task within an assignment are 
presented along with visual aids below. 
 
Students will be asked to review the Community Spreadsheet assignments on the Mpilonhle site. 
 
 
Assignment 1 
 
This assignment will ask students to go through some basic calculations in Excel using the 
following steps: 
 

1. Open Microsoft Excel 
 

2. The student will be asked to find the correct total for the following calculation: 
 

 169 divided by 13   
 
 
For this assignment, students will need to insert the two variables into cells and an equation in a 
new cell to get the result (shown below).  
 
Students will insert: 

 the first variable (169) into a cell 
 the second variable (13) into the next cell below it 
 create an equation in a third box (shown below):  

o type “=” 
o select the first cell 
o type the divide sign “/” 
o select the second cell  
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Hitting the enter button will display the result in the cell. 
 
 

 
 
 
The final submitted answers should appear in the format shown above with the following correct 
answer: 
 

 169 divided by 13 = 13 
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Assignment 2 
 
This assignment will build on the previous assignment and ask students to go through some basic 
calculations in Excel using the following steps: 
 

1. Open Microsoft Excel 
 

2. The student will be asked to find the correct total for the following calculation: 
 

 169 multiplied by 13 
 
 
For this assignment, students will need to insert the two variables into cells and an equation in a 
new cell to get the result (shown below).  
 
Students will insert: 

 the first variable (169) into a cell 
 the second variable (13) into the next cell 
 create an equation in a third box (shown below):  

o type “=” 
o select the first cell 
o type the multiply sign “*” 
o select the second cell button  
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Hitting the enter button will display the result in the cell. 
 

 
 
 
The final submitted answers should appear in the format shown above with the following correct 
answer: 
 

 169 multiplied by 13 = 2197 
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Assignment 3 
 
This assignment will build on the previous assignment and ask students to go through some basic 
calculations in Excel using the following steps: 
 

1. Open Microsoft Excel 
 

2. The student will be asked to find the correct total for the following calculation: 
 

 1442 minus 1329 
 
For this assignment, students will need to insert the two variables into cells and an equation in a 
new cell to get the result (shown below).  
 
Students will insert: 

 the first variable (1442) into a cell 
 the second variable (1329) into the next cell 
 create an equation in a third box (shown below):  

o type “=” 
o select the first cell 
o type the minus sign “-” 
o select the second cell  
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Hitting the enter button will display the result in the cell. 
 

 
 
 
The final submitted answers should appear in the format shown above with the following correct 
answer: 
 

 1442 minus 1329 = 113 
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Assignment 4 
 
This assignment will build on the previous assignment and ask students to go through some basic 
calculations in Excel using the following steps: 
 

1. Open Microsoft Excel 
 

2. The student will be asked to find the correct total for the following calculation: 
 

 1442 plus 1329 
 
For this assignment, students will need to insert the two variables into cells and an equation in a 
new cell to get the result (shown below).  
 
Students will insert: 

 the first variable (1442) into a cell 
 the second variable (1329) into the next cell 
 create an equation in a third box (shown below):  

o type “=” 
o select the first cell 
o type the addition sign “+” 
o select the second cell  
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Hitting the enter button will display the result in the cell. 
 

 
 
 
The final submitted answers should appear in the format shown above with the following correct 
answer: 
 

 1442 plus 1329 = 2771 
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Encarta (Beginner) 

Goal:  To teach students how to use the various search mechanisms available for Encarta to find 
information on a range of topics. 

Time:   30 minutes 

Objectives:  At the end of the Encarta section, students will be able to: 

 Look for topics in Encarta using categories and subcategories to narrow the search. 
 Use the Encarta search box to find information on topics. 

 
 

Encarta Encyclopaedia Basics Lesson  

 

Present the Encarta Encyclopaedia Basics lesson which can also be found on the Mpilonhle 
Moodle site.   

This lesson will provide students with information about the Encarta program and the resources 
which can be found using the software.   

In addition, the lesson will present visual directions for how to use the Encarta search functions. 

 

Encarta 

Encarta is a digital multimedia encyclopaedia created by Microsoft Corporation. The 
encyclopaedia contains more than 62,000 articles as well as pictures, videos and sounds. 

Encarta allows you to search by general category and narrow your search using subcategories. 
For example to find more information about the game of soccer you can follow these steps:  

1. Click on the main category Sports & Recreation.  
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2. Next click on the subcategory folder Sports.  
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3. Next click on the subcategory folder Soccer.  

 

4. On this page you see basic information about the game of soccer. On the left hand side you 
can see categories for different soccer related articles. Click on the any of the other articles to 
find out more information.  
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You can also try a search by typing the subject you are interested into the search box in the top 
right hand corner of the screen. A search for soccer will bring up the most popular articles. It also 
shows articles, pictures, web links and dictionary entries related to soccer.  
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Assignment 

 
Students will be asked to read the instructions for Encarta Basic search exercises and complete 
the online Encarta Quiz 1.  (This quiz will require students to switch between the Encarta 
program and the Internet Explorer web browser). 
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Typing Master (Beginner) 

Goal: To teach fundamental computer skills related to understanding the keyboard and 
developing typing abilities. 

Time:  30 minutes 

Material to present Typing Master Beginner can be found at the end of the Teacher’s manual.  
Additional skills for Intermediate, Advanced I and Advanced II lessons are included. 
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Lesson 2: Intermediate 
 

Lesson 2: Intermediate will provide students with further knowledge and skills of Microsoft 
Word, Microsoft Excel and Encarta.  These topics will build on the information presented in 
Lesson 1: Beginner.   

In addition, students will be introduced to Microsoft PowerPoint and learn basics about the 
program and creating a presentation. 

The lesson is broken into five 30 minute sessions on the following topics: 

 Microsoft Word Intermediate 

 Microsoft Excel Intermediate 

 PowerPoint Beginner 

 Encarta Advanced 

 TypingMaster Intermediate 

 

Microsoft Word (Intermediate) 

Goal:  To teach students how to format text and paragraphs, including creating columns and 
bulleted lists to differentiate text.  Students will also learn how to modify lists of bullets and 
numbers.  

These skills are useful when students wish to create more advanced documents, such as reports 
or articles. 

Time:   30 minutes 

Objectives:  At the end of the Microsoft Word section, students will be able to: 

 Put text into columns  
 Add bullets and numbering   
 Edit bullets and numbering   
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Assignment 

 
Teachers will walk students through the assignment steps and present directions for how to 
complete tasks to the class.  Instructions for how to complete each task within an assignment are 
presented along with visual aids below. 
 
Students will be asked to review the Community Intermediate Word Processing Assignments on 
the Mpilonhle site. 
 
This assignment will ask students to go through the following steps: 
 
Assignment 1: Creating Columns 
 

1. Open Microsoft Word 
 

2. The student will put the following text from the Mpilonhle homepage into two 
columns: 

 
Mpilonhle's Mobile Health and Education Units provide innovative health and education 
programs in rural schools and communities that help prevent HIV and promote general 
health, give medical and social services to those who need it most, and develop the 
computer-based skills and knowledge necessary to succeed economically. 

 
To create columns: 

a) Copy the Mpilonhle text into Microsoft Word 
b) Highlight the Mpilonhle text in Microsoft Word 
c) Click on the Page Layout tab on the top toolbar 
d) Select Columns and choose Two columns 

 

 



42 

 

When finished, the submitted text should look like this: 
 

 
 
 
Assignment 2: Creating a Numbered List 
 

1. Open Microsoft Word 
 

2. The student will create a numbered list of the continents posted below from largest in 
size to smallest: 

 
Continents (from largest to smallest):  
 
Asia 
Africa 
North America 
South America 
Antarctica 
Europe 
Australia 
 
 
To apply numbering to a list: 
 

a) Paste text above into Microsoft Word 
b) Highlight the text  
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c) Select the Numbering icon on the Home tab of the top toolbar and choose 
desired number style (see below) 

 

 
 
 
 
When finished, the submitted text should look like this: 
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Assignment 3: Modifying a Numbered List 
 

1. Open Microsoft Word 
 

2. The student will create a numbered list of the continents posted below from largest in 
size to smallest: 

 
Continents (from largest to smallest):  
 
Asia 
Africa 
North America 
South America 
Antarctica 
Europe 
Australia 
 
 
To apply numbering to a list: 
 

a) Paste text above into Microsoft Word 
b) Highlight the text  
c) Select the Numbering icon on the Home tab of the top toolbar and choose 

desired number style (see below) 
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3. The student will renumber the list starting with the number 2. 
 
To do this, students will: 
 

a) Highlight the numbers and right click 
b) Select Set Numbering Value  

 

 

c) In the popup window that appears, select Set value to: 2 (see below): 
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When finished, the submitted text should look like this: 
 

 
 

 
Additional information 

To apply bullets to a list: 
 

a) Select the Bullets icon on the top toolbar and choose the bullet style desired  
(see below): 
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Microsoft Excel (Intermediate) 

Goal:  To teach students with basic information of how to use a spreadsheet program and present 
some of the number manipulation functions. 

Time:  30 minutes 

Objectives:  At the end of the Microsoft section, students will be able to: 

 Determine the average of a list   
 Determine the largest amount in a list   
 Determine the smallest amount in a list   
 Calculate a percentage  
 Calculate the percentage of an amount  

 
 
 

Assignment 

 
Teachers will walk students through the assignment steps and present directions for how to 
complete tasks to the class.  Instructions for how to complete each task within an assignment are 
presented along with visual aids below. 
 
Students will be asked to review the Community Excel Intermediate assignments on the 
Mpilonhle site. 
 
Assignment 1: Finding Averages 
 
This assignment will ask students to go through some basic calculations in Excel using the 
following steps: 
 

1. Open Microsoft Excel 
 

2. The student will be asked to find the average of the following list: 
 

128 
167 
13 
44 
68 
35  
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To find the average students will: 
 

a) Enter each number in a separate cell all in the same column (see below) 
 

 
 

b) In an empty Excel cell enter the formula:  =AVERAGE( 
 

 
 



49 

 

c) Highlight the list of numbers in a column and hit the enter key. 
 

 

 

d) The average of the list will now appear in the new cell. 
 

 



50 

 

Assignment 2: Sorting a List 

1. Students will be asked to sort the list below from highest to lowest number.  
 

128 
167 
13 
44 
68 
35  

 
a) Highlight the data to be sorted (in this case the list of numbers in column B). 

 
b) To sort, select the Sort button on the Data toolbar. 
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c) Choose Largest to Smallest from the Order drop down section of the popup 
window that appears. 
 

 

 
 
 



52 

 

Assignment 3: Finding a Percentage 
 

1. Find the percentage of 66 divided by 264  
 
To find the percentage, students will:    

a) Enter the two numbers into Excel cells. In a third cell enter the following: 

o Type the = sign 

o Select first cell 

o Type the / sign 

o Select second cell  

o Hit the enter key 
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b) A decimal number will appear after completing these steps. 
 

 

 
 
 

c) Highlight this cell and hit the % key on the Home toolbar to convert the decimal 
into a percentage. 
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d) The result will now be displayed in the highlighted cell. 
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PowerPoint (Beginner) 

Goal:  To teach students how to create a basic presentation using a template and include text, 
graphics and table features. 

Time:  30 minutes 

Objectives:  At the end of the PowerPoint section, students will be able to: 

 Create a slide using a template   
 Add text and graphics to a slide 
 Add tables to a presentation  
 Add graphs to a presentation 
 Copy information   

 
 

Assignment 

 
Teachers will walk students through the assignment steps and present directions for how to 
complete tasks to the class.  Instructions for how to complete each task within an assignment are 
presented along with visual aids below. 
 
Students will be asked to review the PowerPoint Beginner assignment on the Mpilonhle site. 
 
This assignment will ask students to go through the following steps: 
 

1. Open Microsoft PowerPoint 
2. Students will choose a slide template of choice for their presentation.  
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3. For the first slide of the presentation, students will be asked to: 
 

a) Add the title: Mpilonhle 
b) Add a subtitle: A good life 
c) Insert the following graphic found in the Assignment instructions for this activity: 

 

 

 



57 

 

4. To insert the graphic above, students will:  
 
a) Select the image to be inserted, right click, and select copy. 

 

 
 

 
b) In the PowerPoint program, right click on the main slide in PowerPoint and select 

paste to insert copied image. 
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5. Students will then create a second slide which will include the following: 

 
a) Add the title: Mpilonhle 

b) Add a bullet list for: 

 Student Name 
 Age 
 Favourite Activity  

 
 
To create a new slide: 
 

a) Right click on the navigation bar on the 
left hand side of the PowerPoint screen 
and select New Slide 
 

OR 
 

b) Click on the New Slide button on the 
Home toolbar 

 
 
(If you have selected a template for your 
presentation a new slide will be created using 
this template). 
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When finished, the submitted presentation should look like this: 
 

Slide 1 
 

  
 

 
Slide 2 

 

Mpilonhle

 Student Name

 Age 

 Favourite Activity
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Encarta (Intermediate) 

Goal:  To teach students how to conduct more advanced searches for topics using Encarta. 

Time:  30 minutes 

Objectives:  At the end of the Encarta section, students will be able to: 

 Look for information in Encarta using categories and subcategories to narrow the search. 
 Use the Encarta search box to find information on topics. 

 
 

Review Encarta Encyclopaedia Basics Lesson  

 

Review the Encarta Encyclopaedia Basics lesson on the Mpilonhle Moodle site, which was 
presented in the Encarta beginner lesson. 

This brief review of Encarta will remind students about features of the Encarta program and the 
resources which can be found using the software.    

In addition the lesson will present visual directions for how to use the Encarta search functions.  

 

Assignment 

 
Students will be asked to read the instructions for Encarta Intermediate search exercises and 
complete the online Encarta Intermediate Search Quiz.  (This quiz will require students to switch 
between the Encarta program and the Internet Explorer web browser). 
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Typing Master (Intermediate) 

Goal: To teach fundamental computer skills related to understanding the keyboard and 
developing typing abilities. 

Time:  30 minutes 

Material to present Typing Master Intermediate can be found at the end of the Teacher’s manual.  
Additional skills for Advanced I and Advanced II lessons are included. 
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Lesson 3: Advanced I 
 

Lesson 3: Advanced I will provide students with more advanced knowledge and skills of 
Microsoft Word, Microsoft Excel, Microsoft PowerPoint and introduce steps on using messaging 
and blogging.  These topics will build on the information presented in Lesson 1: Beginner and 
Lesson 2: Intermediate.   

The lesson is broken into five 30 minute sessions on the following topics: 

 Microsoft Word Advanced I 

 Microsoft Excel Advanced I 

 PowerPoint Intermediate 

 Messaging and Blogging Beginner 

 TypingMaster Advanced I 

 

Microsoft Word (Advanced I) 

Goal:  To teach students how to insert graphics into a Word document and create borders and 
shading.  Students will also learn how to create borders and shading to a document and add 
images within a Word document.  

These skills are useful when students wish to create more advanced documents, such as reports 
or articles. 

Time:   30 minutes 

Objectives:  At the end of the Microsoft Word section, students will be able to: 

 Set up a page for printing   
 Insert graphics 
 Add borders and shading  
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How to set up a document for printing 

 
Once a document has been completed and saved you may want to print a version of it.  Before 
printing a document it is wise to see a print preview to ensure that the document appears as you 
want it to for the final hard copy print. 
 
To see a print preview: 
 

a) Select Print on the Microsoft Word Main button  
b) Then select Print Preview from the menu that appears 

 

 
 
A preview of your intended print job will appear which will allow you to see what each final 
page will look like.  The top menu will allow you to modify the appearance of the final print job 
(see below). 
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The Margins button will allow you to 
modify how much space is on the page 
around the body of the document.   
 
For most documents you will want to have 
the Normal setting, but you can apply more 
options if you want to be able to fit more or 
less text onto a page. 
 

 
 
 
The Orientation button allows you to 
determine the page layout. The default 
setting for most documents is Portrait, but for 
pages that include charts you may want to 
have the page set out in landscape. 
 
 
Note: The Margins and Orientation buttons 
can also be found under the Page Layout tab 
on the Home toolbar. 

 
 
 

 
 
The Close Print Preview button will allow 
you to leave Print Preview and return to the 
active Word document screen.   
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Assignment 

 
Teachers will walk students through the assignment steps and present directions for how to 
complete tasks to the class.  Instructions for how to complete each task within an assignment are 
presented along with visual aids below. 
 
Students will be asked to review the Word Processing Advanced I assignment on the Mpilonhle 
site. 
 
This assignment will ask students to go through the following steps: 
 

1. Insert the image below into a Word document. 
 

 
 
 

a) Right click on the image and select Copy. 
b) Then open a new Word document. 
c) Right click on the Word document and select Paste. 

 
The image will now appear in the word document. 
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2. Create a red border around the image. 
a) Right click on the image and select Borders and Shading. 

 

 
 

b) In the popup box that appears select: 
 Desired line colour 
 Desired line width 
 Then click on the sides of the Preview image to apply lines to image border. 
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3. Copy the following text and paste it above the image in your word document. 
 

Volcanoes are openings or ruptures in the earth’s surface which allows hot, molten rock, 
ash, and gases to escape from below the surface. 
 

4. Apply blue shading to the text. 
 

a) Highlight the text. 

 
b) Select the shading button on the top toolbar. 
c) Select the desired colour from the drop down menu. 

 

 
 

When finished the submitted text should look like this: 
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Microsoft Excel (Advanced I) 

Goal:  To teach students more advanced functions of a spreadsheet program and present some of 
the options to printing and protecting a worksheet. 

Time:  30 minutes 

Objectives:  At the end of the Microsoft Excel Advanced I section, students will be able to: 

 Set the print range of a spreadsheet 
 Work on multiple worksheets at the same time 
 Create password protection for the worksheet 

 
 

Assignment 

 
Teachers will walk students through the assignment steps and present directions for how to 
complete tasks to the class.  Instructions for how to complete each task within an assignment are 
presented along with visual aids below. 
 
Students will be asked to review the Excel Advanced I assignment on the Mpilonhle site. 
 
This assignment will ask students to go through some basic calculations in Excel using the 
following steps: 
 

1. Add the following numbers into a Microsoft Excel spreadsheet. 
 

 



69 

 

2. Set the print area of this sheet by:  
a) highlighting the area desired 

 

 
 
 

b) Select Page Layout tab on toolbar 
c) Select Print Area button 
d) Select Set Print Area to set the highlighted area 
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e) To preview the page before printing it,  follow the instructions under “How to set up a 
document for printing” 

 
3. Select the bottom three rows of the list and paste them into a new spreadsheet. 

a) Select the desired text, right click and copy 
 

 
 
 

b) Select Sheet2 at the bottom left corner of the page. 
 

 
 

c) Once you click on Sheet2, a new sheet will appear. You can now paste the rows 
of numbers you copied here.  To switch back to your original sheet, simply click 
on Sheet1 at the bottom left corner of your screen. 
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4. Create a password for the worksheet. 
a) Select Review tab on the toolbar 
b) Select Protect Sheet button 

 
 

 
 
 

c) In the popup window that 
appears, type MPILONHLE 
into the Password to unprotect 
sheet: field.   

 
d) Select OK 

 
e) Now the worksheet cannot be 

modified unless the user types 
the password (MPILONHLE).   

 
 
 

 

Note: whenever creating a password, try to use a word or phrase that will be easy to remember.  
Otherwise you risk being unable to access your document again. 
 

To remove password protection from an Excel document: 

 
 

1. Select the Unprotect Sheet button under 
the Review tab of the Home toolbar. 

 

 
 

 
2. Type the password you created into the 

popup box that appears. 

 
 
Password protection will now be removed from the Excel file. 
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PowerPoint (Intermediate) 

Goal:  To teach students how to add and modify a presentation they are working on. Students 
will also learn how to include more advanced features, such as movies and sounds, to a 
presentation.  

Time:  30 minutes 

Objectives:  At the end of the PowerPoint section, students will be able to: 

 Add slides to a presentation 
 Move the order of slides 
 Add notes to a slide 
 Add transitions between slides 

 
 

PowerPoint Features 

The PowerPoint program allows you to customize your presentation and modify what you have 
created.  Creating and moving slides is an important way to add content to your presentation and 
determine the order you want to present information.   

Adding notes to a page allows you to make sure that you have important information about a 
particular slide. Notes will not appear when you present your PowerPoint slide show, but can be 
printed out to help you remember important points while you make your presentation. 

Adding transitions between slides allows you to determine how you want slides to appear from 
one to the next as you present.  

Assignment 

 
Teachers will walk students through the assignment steps and present directions for how to 
complete tasks to the class.  Instructions for how to complete each task within an assignment are 
presented along with visual aids below. 
 
Students will be asked to review the PowerPoint Intermediate assignment on the Mpilonhle site. 
 
This assignment will ask students to go through the following steps: 

 
1. Open the presentation saved from the PowerPoint Beginner assignment. 
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2. Add a new slide to the presentation 
 

To create a new slide: 
 

a) Right click on the navigation bar on the 
left hand side of the PowerPoint screen. 
 

b) Select New Slide 
 
(If you have selected a template for your 
presentation, a new slide will be created using 
this template). 

               
 

3. Add the title Mpilonhle to the new slide 
4. Insert the graphic below into the new slide. 
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5. Switch the order of your slides so that the new slide is the second slide in the 
presentation. 
 

 
 
 
 
 

a) Left click on the slide you wish to 
move. 
 

b) Drag slide to desired location in 
the slide order list. 

 

 

c) The slide will now appear in the 
new location selected. 

           



75 

 

6. Add the following text into the notes section of the slide you just created: 
 

This image is the official Mpilonhle logo. 
 

To add notes, simply type text into the notes section at the bottom of the slide. 
 

 
 
 

7. Select a different transition for each slide. 
 

a) To add a transition click on the slide you want to add the transition to 
b) Select the transition you prefer from the Animations tab on the Home Menu 
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8. Once you have finished working on your presentation, you can view it by clicking on the 
Slide Show button in the bottom right corner of your screen.  
 
Note this button is very small and may be easy to miss. 
 

 
 
To move forward or backwards through the slides in the presentation, use the → and  ← 
keys on your keyboard. 
 
→  key to move to the next slide in the presentation 
 
←  key to move backwards to previous slides in a presentation.  
 
 
As you progress through a presentation, you will be able to see the transitions you chose 
between each slide. 
 
These transitions are a way to customize your presentation and make your slide show 
look more professional. 
 
 

→ →

   
  
 
 
 
 

 



77 

 

Messaging and Blogging (Beginner) 

Goal:  To teach students how to use the basic messaging and blogging features of the Mpilonhle 
Moodle site. 

Time:  30 minutes 

Objectives:  At the end of the Messaging and Blogging section, students will be able to: 

 Use the message features to send and receive messages 
 Start their own blog 
 Post new blog entries 

 

What is a message? 

 
 
Messages can be sent from your account to any other account set up on the Moodle site.  You 
can send messages to anyone in class including your teachers.  You can also check to see if other 
people have sent messages to you or responded to what you have sent them. 
 
 

Messaging Assignment 

 
Teachers will walk students through the assignment steps and present directions for how to 
complete tasks to the class.  Instructions for how to complete each task within an assignment are 
presented along with visual aids below. 
 
Students will be asked to review the Message beginner assignment on the Mpilonhle site. 
 
 
This assignment will ask students to send a message to their teacher by going through the 
following steps: 
 

1. Click on the Participants button on the top left of the screen. 
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A new screen will now appear with a list of all participants in the course. 

 

 

2. Find the name of the teacher you would like to send a message to and click on it.  You 
will be brought to the Profile page.   

 

3. On the bottom of their information, there is a Send message button.  Click this button to 
prepare a message to be sent to this teacher (see below). 

 



79 

 

 

 

4. Type your message in the popup window that appears.  Once you have written your 
message, click the Send message button. Your teacher will receive your message 
instantly!     
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5. To read messages sent to you: 

 
 

a) Click on the Envelope icon in the 
Messages section in the upper right hand 
corner of the Mpilonhle Computer 
Curriculum main page. 

 
Note: In the Message section you will be able 
to see who sent you messages and the number 
of messages you have received. 
 

 
 

 
 
 

b) A popup window will appear that presents 
the message you received. 
 

c) You will also be able to respond directly to 
this message by entering text into the box 
and clicking the Send message button. 

 
 
 

What is a blog? 

The word “blog” is a combination of the words “web log.”  Have you ever kept a journal?  A 
blog is like an online journal, except that you can let other people read your entries.  You can 
keep your daily thoughts or post any information about yourself.  You can also add features to 
your blog such as posting pictures or photos. 
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Blogging Assignment 

 
Teachers will walk students through the assignment steps and present directions for how to 
complete tasks to the class.  Instructions for how to complete each task within an assignment are 
presented along with visual aids below. 
 
 
Students will be asked to review the Blogging beginner assignment on the Mpilonhle site. 
 
 
This assignment will ask students to write their own blog through the following steps: 
 
 

 
1. To begin go to the Blog Menu in the top right corner of the Mpilonhle Computer 

Curriculum screen. 
 

2. Select Add a blog. 
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3. Add a title to your blog and content in the new page that appears. 
 

 
 

 
4. Once you are finished, select the Save changes button on the bottom of the page. 

 

 
 

5. To view your blog or edit it once it has been saved, click on the View my blogs in the 
Blog Menu on the Mpilonhle Computer Curriculum page. 
 

6. To view other people’s blogs, click on the View site entries in the Blog Menu on the 
Mpilonhle Computer Curriculum page. 

 

 



83 

 

Typing Master (Advanced I) 

Goal: To teach fundamental computer skills related to understanding the keyboard and 
developing typing abilities. 

Time:  30 minutes 

Material to present Typing Master Advanced I can be found at the end of the Teacher’s manual.  
Additional skills for Advanced II lessons are included. 
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Lesson 4: Advanced II 
 

Lesson 4: Advanced II will provide students with advanced knowledge and skills of Microsoft 
Word, Microsoft Excel, Microsoft PowerPoint, and Wikipedia.  These topics will build on the 
information presented in Lessons 1-3.   

The lesson is broken into five 30 minute sessions on the following topics: 

 Microsoft Word Advanced II 

 Microsoft Excel Advanced II 

 PowerPoint Advanced I 

 Wikipedia Beginner 

 TypingMaster Advanced II 

 

Microsoft Word (Advanced II) 

Goal:  To teach students how to find and replace text in a Word document.  Students will also 
learn how to finalize a document by running a spell check on a document.    

These skills are useful when students wish to create more advanced documents, such as reports 
or articles. 

Time:  30 minutes 

Objectives:  At the end of the Microsoft Word section, students will be able to: 

 Find text 
 Replace text 
 Spell check  

 
 
 
 



85 

 

Finding Selected Text and Replacing Text 

 
When reviewing a document, whether a paper you have written or one that you are reading, it 
can often be useful to use the find text feature to search for certain words or phrases.  Rather than 
reading through a long document and trying to find a particular sentence or topic, you can search 
for a phrase that will bring you to that section of the document. 
 
A second useful feature is the replace text feature which allows you to choose a word or phrase 
in a document and replace it with an alternate word or phrase whenever that first phrase appears. 
For example, rather than the word soccer appearing in a document, you may want to replace the 
word with football.  By using the replace text feature, every time the word soccer appears, it will 
be replaced with the word football. 
 
 

Finding Selected Text and Replacing Text Assignment 

 
1. Copy the phrase below and paste it into a Word document. 

 
2. Find the word sport wherever it appears in the following phrase: 

 
Soccer is a team sport played between two teams of eleven players, and is widely considered to 
be the most popular sport in the world.  It is a football variant played on a rectangular grass or 
artificial turf field, with a goal at each of the short ends. The object of soccer is to score by 
maneuvering the ball into the opposing goal. In general play, the goalkeepers are the only players 
allowed to use their hands or arms to propel the ball; the rest of the team usually use their feet to 
kick the ball into position, occasionally using their torso or head to intercept a ball in midair. The 
team that scores the most goals by the end of the match wins. If the score is tied at the end of the 
soccer game, either a draw is declared or the game goes into extra time and/or a penalty 
shootout, depending on the format of the competition. 
 
To use the find text feature: 
 

a) Highlight the text 
b) Press the Ctrl and the F button on your keyboard 
c) In the popup box that appears, type sport 
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d) Shade the word sport blue everywhere it appears in the text. 
 Highlight the word sport 
 Select blue shading from the button on the Home toolbar 

 

 
 

 Do this for each time the word sport appears in the text 
 

3) Replace the word soccer with the word football every time that it appears in the text. 
 
To use the replace text feature: 
 

a) Highlight the text 
b) Press the Ctrl and the F button on your keyboard 
c) Select the Replace tab 
d) In the popup box that appears, type soccer into the Find what: field 
e) Enter football into the Replace with: field 
f) Select the Replace All button 
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The final text should look like this: 
 

 
 
 

Using the Spelling & Grammar Check 

 
The Spelling & Grammar Check feature of Microsoft Word is a useful tool to finalize 
documents.  Sometimes even the best writers make mistakes.  Using the Spelling & Grammar 
Check helps the reviewer to find typos, misspellings, and incorrect grammar in a document.  It is 
helpful to run the Spelling & Grammar Check before submitting a final document. 
 
 

Spelling & Grammar Check Assignment 

 
1. Copy the phrase below and paste it into a Word document. 

 
2. Find the word spelling and grammar errors in the following paragraph: 
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Football is played in accordance with a set of rules known as the Laws of the Game. The game is 
played using a single spherical ball, known as the football. Two teams of eleven players each 
compete to get the ball into the other team's goal (between the posts and under the bar), thereby 
scoring a goal. The team that has scored more goals at the end of the game is the winner; if both 
teams have scored an equal number of goals then the game is a draw. 

 
To run the Spelling & Grammar Check: 
 

a) Highlight the text 
b) Select the Spelling & Grammar button under the Review tab of the Home toolbar 

 

 
 

c) A popup window will appear presenting grammar and spelling mistakes. There are a 
number of options you can choose for each error that appears. 

 
 Click the Ignore Once button to skip to the next error without changing the error 

currently being shown. 

OR 

 Click the Change button to replace the error being shown with the Suggestion 
shown below. 

OR 

 Directly make a change to the text by clicking into the Possible Word Choice 
Error box and typing the new desired text. 
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d) Once you have selected one of these options, the next error will appear in the popup box. 
 

e) Go through the text until all desired changes have been made. 
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Excel (Advanced II) 

Goal:  To teach students more advanced functions of a spreadsheet program and present some of 
the options for creating graphs. 

Time:  30 minutes 

Objectives:  At the end of the Microsoft Excel Advanced II section, students will be able to: 

 Create a Bar Graph 
 Create a Line Chart 
 Create a Pie Chart 

 

Assignment 
 

Teachers will walk students through the assignment steps and present directions for how to 
complete tasks to the class.  Instructions for how to complete each task within an assignment are 
presented along with visual aids below. 
 

Students will be asked to review the Excel Advanced II assignment on the Mpilonhle site. 
 

This assignment will ask students to go through some basic calculations in Excel using the 
following steps: 
 

1. Add the following lists into two columns in an Excel document: 
 
Stephen 
Michael 
Susan 
Jill 
Timothy 

26 
78 
14 
88 
65 

 

2. Create a Bar Graph from the data provided in these two lists. 
a) Highlight both columns of data. 
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b) Click on the Bar button under the Insert tab of the Home toolbar. 
 

c) Select Clustered Bar under the 2-D Bar section of the drop down menu that 
appears under the Bar button. 

 

 
 

d) A Bar Graph will now appear in the Excel spreadsheet. 
 

e) Use the features under the Design tab of the Home toolbar to choose a colour for 
your Bar Graph. 
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3. Create Line Chart from the data provided in these two lists. 
 

a) Highlight both columns of data. 
 

 
 

b) Click on the Line button under the Insert tab of the Home toolbar. 
 

c) Select Line under the 2-D Line section of the drop down menu that appears under 
the Line button. 

 

 
 

d) A Line Chart will now appear in the Excel spreadsheet. 
 

e) Use the features under the Design tab of the Home toolbar to choose a colour for 
your Line Chart. 
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4. Create a Pie Chart from the data provided in these two lists. 
a) Highlight both columns of data. 

 

 
 

b) Click on the Pie button under the Insert tab of the Home toolbar. 
 

c) Select Pie in 3-D under the 3-D Pie section of the drop down menu that appears 
under the Pie button. 

 

 
 

d) A Pie Chart will now appear in the Excel spreadsheet. 
 

e) Use the features under the Design tab of the Home toolbar to choose a colour for 
your Pie Chart. 
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When finished, the submitted presentation should look like this: 
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PowerPoint (Advanced I) 

Goal:  To teach students how to add images from the clip art database.  Students will also learn 
how to add audio features to their presentation from the clip art folder.  Features such as audio 
add more professional aspects to a presentation. 

Time:  30 minutes 

Objectives:  At the end of the PowerPoint section, students will be able to: 

 Add clip art images to a PowerPoint slide 
 Add audio to a PowerPoint slide  

 

Assignment 

 
Teachers will walk students through the assignment steps and present directions for how to 
complete tasks to the class.  Instructions for how to complete each task within an assignment are 
presented along with visual aids below. 
 
Students will be asked to review the PowerPoint Advanced assignment on the Mpilonhle site. 
 
This assignment will ask students to go through the following steps: 

 
 
 
 
 
 

1. Open the presentation saved from the 
PowerPoint Beginner assignment. 
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2. Add a new slide to the presentation 
 

To create a new slide: 
 

c) Right click on the navigation bar on the 
left hand side of the PowerPoint screen. 
 

d) Select New Slide 
 
(If you have selected a template for your 
presentation, a new slide will be created using 
this template). 

               
 
 

3. In the new slide, add a clip art image of rain. 
 

a) Select Movie from Clip Organizer under the Insert tab of the Home toolbar 
 

 
 

 



97 

 

 
 
 
 

b) In the menu that appears, Search for 
the term rain. 
 

c) Click Go to get a selection of rain 
related images. 
 

d) Select one of the files from the list. 
 

e) Drag this image onto the new slide and 
expand to the size desired. 

 
 
 

4. Add a sound clip from the clip art folder. 
 

a) Select Sound from Clip Organizer under the Insert tab of the Home toolbar 
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b) In the menu that appears, Search for 
the term rain. 

 
c) Click Go to get a selection of rain 

related sounds. 
 

d) Select one of the files from the list. 
 

e) Double click on this sound file to add it 
to the new slide. 

 
f) In the popup window that appears, select the Automatically button 

 

 
 

g) Now after you transition from the previous slide to this slide, you will hear rain sounds to 
go with the image you selected. 

 
 

5. Once you have finished working in PowerPoint, you can view the presentation by 
clicking on the Slide Show button in the bottom right corner of your screen.  
 
Note this button is very small and may be easy to miss. 
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To move forward or backwards through the slides in the presentation, use the → and ← 
keys on your keyboard. 
 
→  key to move to the next slide in the presentation 
 
←  key to move backwards to previous slides in a presentation.  
 
 
As you progress to the last slide of the presentation, you will be able to see the image of 
rain you selected and hear the audio file you selected. 

 
 
When finished, the submitted presentation should look like this: 
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Wikipedia (Beginner) 

Goal:  To teach students how to navigate to resources on a popular web-based encyclopaedia. 

Time:  30 minutes 

Objectives:  At the end of the Wikipedia section, students will be able to: 

 Look for topics in Wikipedia using categories and subcategories to narrow the search. 
 Navigate to additional topics by clicking on links. 

 
 

Wikipedia Basics Lesson  

 

Present the Wikipedia Basics lesson which can be found on the Mpilonhle Moodle site.   

This lesson will provide students with information about Wikipedia and the resources which can 
be found using Wikipedia.   

In addition, the lesson will present visual directions for how to use Wikipedia. 

 

Wikipedia 

(from Wikipedia) Wikipedia is a multilingual, Web-based, free-content encyclopaedia project. 
The name "Wikipedia" is a portmanteau (a combination of portions of two words and their 
meanings) of the words wiki (a type of collaborative Web site) and encyclopaedia. Wikipedia's 
articles provide links to guide the user to related pages with additional information. 

The 2008/9 Wikipedia Selection for schools allows you to navigate by Subject Index, which is 
organized by subject along the lines of subjects in the UK curriculum, or by Title Word Index, 
which includes words from all article titles included in the selection. 
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To navigate by Subject Index, click on Subject Index in the upper right hand corner of the 
webpage.  To navigate by Title Word Index, click on Title Word Index in the upper right hand 
corner of the webpage. 

From the Subject Index page, to find information on South Africa:  

 

a) Click on Countries 
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b) Then click on Africa  

 

 

 

c) Then click on South Africa  

 

 

Within the text of the article on South Africa, if you want to find more information about any of 
the subjects in blue, simply click on the blue word and it will take you to an article on that 
subject. 
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From the Title Word Index page, to find information about HIV:  

 

a) Click on the letter H in the 
alphabet list at the top  

 

 

 

 

b) Then click on HIV 

 

 

 

Within the text of the article on HIV, if you want to find more information about any of the 
subjects in blue, simply click on the blue word and it will take you to an article on that subject. 
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Assignment 

 
Teachers will walk students through the assignment steps and present directions for how to 
complete tasks to the class.  Instructions for how to complete each task within an assignment are 
presented along with visual aids below. 
 
Students will be asked to read the instructions for Wikipedia Basic search exercises and complete 
the online Wikipedia Quiz Beginner.  This quiz will require students to switch between two tabs 
on their web browser, one with Wikipedia open and the other with the Mpilonhle Moodle site 
open. 
 
 
To open Wikipedia in a new tab of your web browser: 
 

a) Hit the Ctrl key and the T key at the same time 
 
 
OR 
 
 
 

 
 
 
 

b) Under the File menu, select New Tab.   
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To navigate between tabs, simply click on the tab you would like to view. 
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Typing Master (Advanced II) 

Goal: To teach fundamental computer skills related to understanding the keyboard and 
developing typing abilities. 

Time:  30 minutes 

Material to present Typing Master Advanced II can be found at the end of the Teacher’s manual.   
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Typing Master  
 

Goal:  To help students improve their typing ability through a series of exercises and games. 

Time:  30 minutes  

Objectives:  At the end of the Typing Master section, students will: 

 Improve skills and speed typing with the keyboard. 
 Be able to progress through lesson topics and progress through lessons. 

 

Getting started with Typing Master 

 

The Typing Master lesson can be found on the Mpilonhle site under the main Computer 
Curriculum page.  

 

When students click on the Typing Master button the program will load the following screen: 

 



108 

 

A Lesson is comprised of a series of readings to provide knowledge about the keyboard, 
exercises to improve typing ability, and a Lesson exam which encapsulates the content and skills 
presented in the Lesson. 

 

 

Present Topic 1.1 Touch typing basics to students to provide them with an overview of 
important typing skills. 

Once Topic 1.1 has been presented, have students proceed to Topic 1.2 New keys: Home row. 
This topic has students type on their keyboards as they go through the material. 

After the class has had an opportunity to go through the first two topics, allow students to try the 
exercises and activities Topics 1.4, 1.5 & 1.6 

These activities will score students and allow them to build up their typing ability. 
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Typing Master Additional Material 

 

Intermediate Lesson 

 

To continue with Intermediate typing lessons, launch Typing Master from the Mpilonhle Moodle 
site. 

 

To move to Lesson 2, select the skip to the next lesson button in the bottom right corner of the 
screen. 
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A new set of typing topics will now be displayed: 

 

 

Present the following topics to students: 

Topic 2.1 New Keys E and I  

Topic 2.2 Word drill 

Topic 2.3 WordTris 

 

Once these topics have been presented allow students to progress through remaining topics to 
build upon the skills presented in the first three topics. 
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Advanced Lesson I 

 

To continue with Advanced I typing lessons, launch Typing Master from the Mpilonhle Moodle 
site. 

 

 

To move to Lesson 3, select the skip to the next lesson button in the bottom right corner of the 
screen. 
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A new set of typing topics will now be displayed: 

 

 

Present the following topics to students: 

Topic 3.1 New keys: R U  

Topic 3.2 Word drill 

Once these topics have been presented, allow students to progress through remaining topics to 
build upon the skills presented in the first three topics. 
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Advanced Lesson II 

 

To continue with Advanced II typing lessons, launch Typing Master from the Mpilonhle Moodle 
site. 

 

 

To move to Lesson 4, select the skip to the next lesson button in the bottom right corner of the 
screen. 
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A new set of typing topics will now be displayed: 

 

 

Present the following topics to students: 

Topic 4.1 New keys: T O  

Topic 4.2 Word drill 

Once these topics have been presented, allow students to progress through remaining topics to 
build upon the skills presented in the first three topics. 
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Professional Development 
 

The Professional Development section of the Mpilonhle Community Computer Curriculum is 
designed to present learners with an opportunity to apply computer skills toward creating 
resumes, cover letters and other resources useful to the job market.  

 

Building a Resume 

Goal: To teach students how to use templates in Microsoft Word to create a professional resume 
based on a resume sample. 

Time:  30 minutes 

Objectives:  At the end of the Building a Resume section, students will be able to: 

 Understand the value of a professional resume 
 Select a resume template in Microsoft Word 
 Fill out resume fields in a template 
 Finalize a professional resume 

 
 

A resume, which can also be referred to as Curriculum Vitae, is an important tool to present the 
skills and background of a job candidate to prospective employers.  A resume provides a detailed 
record of a jobseeker’s skills, education, previous employment, professional affiliations and 
other relevant experience. 

Employers receive many applications for a job posting; as a result an applicant’s resume needs to 
stand out and make a lasting first impression.  A strong resume should be professional, concise 
and avoid errors in spelling and grammar.  Resumes should be tailored to the position being 
applied for based on the posted job description. A resume should be written in English, as this is 
the language used in business in the South African job market. In order to strengthen your 
resume, use concise and strong language in your writing.  Include the use of verbs such as 
contributed, organized, demonstrated, trained, managed, developed, and coordinated.  

A resume can be broken into different sections.  While not all resumes may have each of these 
sections here are some commonly found components: 
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1. Personal Details 
2. Professional Experience 
3. Education 
4. Skills  
5. Activities and Affiliations 
6. Language 
7. References 

 

Depending on the strength of your experience you may wish to present Professional Experience, 
Education or Skills section first.  A resume should be created to best represent the skills and 
background you have and present you as a strong job candidate. 

 

1. Personal Details 

The Personal Details section should include any relevant information about you.   

 Name 
 Address 
 Telephone 
 Email 
 Birth Date/ Age 
 Nationality 
 Gender/ Status 
 Race 

 
An example of the Personal Details section can be found in the sample resume provided.  In the 
sample resume Name, Address, Telephone, and email information is found at the top of the 
resume.  Information related to Birth date, Age, Nationality, Gender, Status, and Race are found 
in the Personal Details Section below. 

2. Professional Experience 

The Professional section should present:  

 the job title of any current or prior job positions you have held 
 the company information and dates when you held these positions 

 

In addition to information about your job title and the company for which you worked, you 
should provide a short summary about the nature of the work you conducted.  This may be a 
short paragraph or a bulleted list of responsibilities and accomplishments or a combination of the 
two formats. 
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An example of the Professional Experience section can be found in the sample resume 
provided. 

 

3. Education 

The Education section should present:  

 the degree(s) you have obtained  
 the school(s) and date(s) at which you received your degree(s) 
 the subject in which you received your degree(s) 
 any special honours  
 and an optional section of relevant course work  

 

An example of the Education section can be found in the sample resume provided. 

 

4. Skills 

Your resume has already presented your educational and professional background. The Skills 
section is an opportunity to focus on additional skills you may have that are not presented in 
these other two sections. These skills may include personal skills such as: quick learner and 
excellent communication skills.  These skills may also include information about proficiencies in 
business applications such as computer programs (Microsoft Word, PowerPoint). 

An example of the Skills section can be found in the sample resume provided. 

 

Note:  Successful completion of the Mpilonhle course will provide you with proficiencies in the 
following programs: Microsoft Windows Operating System, Microsoft Word, Microsoft Excel, 
PowerPoint, Encarta digital library. 

 

5. Activities and Affiliations 

The Activities and Affiliations section should present:  

 community organizations to which you belong 
 volunteer experience 
 personal activities and interests 
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An example of the Activities and Affiliations section can be found in the sample resume 
provided. 

 

6. Language 

The Language section should present:  

 languages you know 
 level of spoken, reading and writing ability in each language 

 
 
An example of the Language section can be found in the sample resume provided. 
 

7. References 

 

The References section should present:  

 the names and contact information for several references  
 indicate whether the relationship with referee is professional or personal 

 
 
An example of the References section can be found in the sample resume provided. 
 

Assignment 

This assignment will ask students to go through the following steps: 
 

1. Open Microsoft Word 

2. Click the Microsoft Office Button,   
3. Select New  
4. Then click Installed Templates 
5. Select Resumes and CVs (All the resume templates currently installed on our computer 

will be listed).  
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6. Highlight the Chronologic resume (Traditional design) template and click Create. 

A new file will open in the template you’ve selected.  
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7. Begin filling out the resume fields in the new template with your background information 
and qualifications. 
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Note: For guidance on how to fill out your resume review the sample resume provided. 
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Building a Cover Letter 

Goal: To teach students how to use templates in Microsoft Word to create a cover letter based on 
a sample letter. 

Time:  30 minutes 

Objectives:  At the end of the Building a Cover Letter section, students will be able to: 

 Understand the purpose and value of a professional cover letter 
 Select a cover letter template in Microsoft Word 
 Fill out fields in a template 
 Finalize a professional cover letter 

 

In addition to a resume a cover letter is an essential part of your job application process. The 
cover letter should expand on your personal qualifications and present what unique contributions 
you can add to an organization. Write in a few lines how your experience and expertise can 
contribute to the company.  A cover letter should also refer to your present and future plans, 
showing your prospective employers what you want to do now and what you will do for them in 
the future. 

A cover letter should be one paged typed and written in English.  The letter should be 
professional, concise and avoid errors in spelling and grammar.  Cover letters should be tailored 
to the position being applied for based on the posted job description.  

It is customary to follow up with your cover letter by phone. 

 

Assignment 

This assignment will ask students to go through the following steps: 
 

1. Open Microsoft Word 

2. Click the Microsoft Office Button,   
3. Select New  
4. Then click Installed Templates 
5. Select Letters and then select Cover letters (All the resume templates currently installed 

on our computer will be listed).  
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6. Highlight the Resume cover letter in response to ad, longer template and click 

Create. A new file will open in the template you’ve selected.  
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7. Begin filling out the cover letter fields in the new template with your name and address 
and the name and address of the potential employer.   

Remember to carefully read the letter template and modify the template to match 
job specifications. 
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Interviewing Advice 

When preparing for an interview make sure to research the organization and position you are 
applying for thoroughly.  This will enable you to answer questions well, and demonstrate 
knowledge and initiative in your own questions about the company. 
 

An important part of an interview is first impressions and professional appearance.  Dress 
conservatively in business clothing this means suits or sports coats and dress pants for men and 
dresses or suits for women. 

Being punctual for your interview is very important. As an applicant you should arrive five to ten 
minutes before the interview. Being late creates a negative impression. If you are going to be 
late, it is important to contact your interviewer to keep them informed and provide an 
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explanation for the delay.  If you think you will be delayed for longer than an hour, it is a good 
idea to ask the interviewer to reschedule at their convenience. 

An interview will usually start with introductions.  Remember to use formal greetings and 
references when talking to interviewers.  Use terms such as, “Mr.” or “Mrs.” Or “Ms.” during 
your exchange.  You are likely to be asked questions about your experience, and asked what 
solutions you may have to potential problems that can arise on the job. Listen carefully to 
questions and remember to speak clearly and confidently when answering. Be prepared to 
discuss your strengths, weaknesses, background, and accomplishments. 

 


